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PART 1
Professional Kitchen Design for Beginners

In this section, we’ll deal with the various components of the kitchen and how to 
arrange them on your plan then in Section 2 I’ll show you exactly how to set-up MS 
Word to create detailed, accurate drawings to work from. 

INTRODUCTION

Most of us consider the kitchen to be the ‘heart of the home’.  The room where 
you’ll spend a lot of your time and where everyone usually ends up at parties! 
More importantly though, the kitchen is often one of the biggest selling points of a 
house if you ever decide to sell it.

A well thought out kitchen plan is essential then if it is to be functional, effective 
and most of all – safe.

This quick and easy guide will help you to ensure that your plan makes maximum 
use of the space available and best suits your circumstances.  A little time spent at 
this stage will save you from making potentially expensive mistakes later.

PLANNING

Kitchen design is relatively straightforward in most cases and really just relies on 
accurate measuring and knowing what cabinets & appliances are available to fit in 
the space you have.

In any kitchen there are 3 main ‘zones’ which professional planners try to tie 
together to create a working triangle.

1. Food storage & preparation – fridge and worktop area
2. Cooking – oven, hob, microwave
3. Washing up – sink and dishwasher

Before putting pencil to paper (or finger to keyboard in our case) you have to give 
some thought to your circumstances.

Things to consider:

• What’s your budget?
• What’s your timescale?
• Who’s going to install it – you, or professional fitters?
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• Do you have alternative means of cooking - microwave, take-away?
• Do you want to retain the same basic layout or completely change it?
• If you’re changing layout, can the services be moved easily (is there access 

under the floor for example?)

Your circumstances will affect not only the style of the kitchen but the type of 
units you use, the appliances you specify and the kind of accessories you want to 
incorporate. So…

Who’s going to use it? – are you:
• a single person living on your own, 
• a couple, 
• or a family with one or more children

What are you going to use it for:– 
• will you just cook in it,
• do you have a utility room where you do your laundry,
• will you entertain in it,
• will your kids watch TV in it

Are you just looking to give it a quick makeover or do you want to completely 
redesign it?

 Tip: if you live in a relatively modern home, before you decide to completely 
change everything around, remember that at some point a highly qualified 
architect has used his experience to design an efficient and effective layout for the 
space you have available.  In this situation, I would recommend sticking with this 
basic layout unless you plan to enlarge your kitchen with an extension or by 
knocking-through into another room.

LAYOUTS

The shape of your room will dictate, to a large extent, the basic layout of your 
kitchen.  Most kitchens fall into one of the following configurations:

Straight Line – if you have a very narrow room, you may be limited to just a single 
run of worktop.  Although you can’t really achieve a ‘working triangle’ as such, it’s 
still possible to group your appliances together to make the best use of the space 
available.  In this case, most of your storage will probably be in wall units.
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In this example, notice the washing machine and dishwasher are either side of the 
sink for ease of plumbing.  In most properties you will tend to find the sink beneath 
the window if there is one. There’s also adequate space between the hob and sink 
- which needs to be at least 600mm for current building regulations.

Galley – if you have a square or rectangular shaped room with a door at each end 
then a galley layout is probably the most effective for you.  To use this layout your 
room will need to be at least 2.4m wide to allow a 600mm worktop on either side 
and a 1200mm gap between them for walking space when cupboard doors and 
drawers are opened.

Kitchen measurements are usually expressed in millimetres (mm): 1000mm = 
1metre and 100mm = 10centimetes (cm).
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L-Shaped – this kitchen shape is ideal if you only have two useable walls to build 
out from.  This configuration tends to leave a nice open space in the centre of the 
room – handy if you want to use a table and chairs or if you simply want a light and 
airy kitchen (just because you have available wall and floor space, it doesn’t mean 
you have to fill it with units).

 Tip: Avoid locating your fridge or freezer right next to your oven if you can, 
otherwise it’s going to have to work much harder than normal to keep cool.

U-Shaped – if you only have one door leading into or out of your kitchen and you 
have three useable walls, then a U-shaped configuration might be perfect for you. 
With this layout you’ll get maximum space for units and appliances.  The only thing 
to remember, as before, is that you need at least 1200mm between opposing rows 
of base units to allow you to open doors and still walk past.
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Island – if you’re lucky enough to have a large kitchen then you might want to 
consider an island layout.  In the right setting they can look fantastic and be a real 
feature of the house.  Normally you would create an L or U-shaped layout as above 
but with the addition of a central ‘island’.  This can be used simply for storage or, 
for the more adventurous, it’s possible to have your hob located here with an 
island extractor above it.  Obviously this depends on being able to run services to 
the island under the floor.

The other appeal of this kind of design is that, if large enough, the island can 
double as a breakfast bar.  Although you could use 665mm breakfast bar worktop if 
space is tight, it’s better to use 900mm wide worktop if you can so that you can 
place bar stools underneath it.  The same regulations apply as before in that you 
will need to have at least 1200mm between the island and adjacent worktops/units 
to allow for easy passage when doors/drawers are opened.
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SAFETY GUIDELINES

Before we get into how to layout the units and appliances, we need to quickly go 
over some safety issues so that your design is in keeping with current UK Building 
Regulations.  This list is not exhaustive and if you are in any doubt about any 
aspect of your design and installation, please seek professional advice.

You will see that most recommendations concern the siting of the hob which makes 
sense given that it is potentially one of the more dangerous pieces of equipment in 
your kitchen.

Hob Do’s & Don’t’s:

Do - 
• Leave a minimum distance between the hob and the sink of 600mm (24”) if 

they are on the same run of worktop.
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• Leave at least 200mm on either side of a hob to ensure that surrounding walls 
or tall units aren’t damaged by the heat and to allow easier pan handle 
movement.

• Allow at least 760mm (30”) clear space above the hob (this includes 
extractors and wall units)

Don’t – 

• Position your hob and oven behind a door, in case the door is opened while 
you are at the hob or putting something in the oven.

• Locate the hob underneath a window.  Draughts from an open window can 
blow out the flames of a gas hob and leaning across a lit hob to close a 
window is obviously dangerous.

General Guidelines

Worktops must be supported by a base unit or with a worktop support panel every 
600mm (e.g. between two appliances).

Try to avoid short runs of worktop less than 1000mm in length.

As I’ve already mentioned above, you need to leave a gap of at least 1200mm 
between two parallel rows of units e.g. on an L or U shaped layout.

MEASURING

Although this guide is all about showing you how to design your kitchen using MS 
Word, initially you’ll still need a pen and paper to make a rough sketch of your 
kitchen.  This only needs to be a simple line drawing to mark your dimensions on.

 Tip: Because very few houses actually have perfectly straight and square 
walls, measure the length and breadth of the room at floor level first, then again 
at a height of 900mm (approximate worktop height).  Use the smaller of the two 
measurements for your plan.

Make a note of the location of doors, windows, central heating boilers and any 
other fixed features which you will have to work around.  When measuring the 
position of doors and windows, measure from the edge of the wall to the outer 
edge of the door or window frame (i.e. to the edge of the decorative facing), to 
get the overall size.  For windows, measure the height from the floor to the bottom 
of the sill too.  
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If you have a staircase above part of your kitchen and have a sloped section of 
ceiling, then you’ll also need to make a note of this as it will be a factor when it 
comes to hanging your wall units.  Even though these measurements are being 
noted down on a rough sketch, they still need to be accurate. 

At this stage, also jot down on your drawing the location of the services.  All 
kitchens will have at least water and electricity supplies and in most cases these 
days, gas too.  The position of these services must be taken into account in your 
kitchen plan.  If your kitchen has a concrete floor or limited under-floor access 
then it may not be practical to move the location of gas and water supplies, so 
keep this in mind before completely changing your layout!  Thankfully, adding 
extra electrical sockets and switches should be quite straightforward, as your 
electrician can often just extend the existing circuit.

DESIGN

Now that you have the measurements of the room, it’s time to give some thought 
to the design.  By now you’ve hopefully decided on the basic layout – galley, U-
Shaped etc.  Starting at floor level, decide which appliances you would like and 
where these will need to be located with regard to what we’ve learned so far. 
Decide on the location of the sink at this stage too.

 Tip: Try to keep the sink in its existing position if this where the water main 
enters the house from under the floor – moving it will be time-consuming and 
costly.

 Tip: Keep dishwashers and washing machines positioned close to the sink to 
simplify plumbing.

If you plan on having a cooker hood, these should ideally be located on an external 
wall so they can be vented to the outside.  To do this you will need to cut a 4” hole 
through the brickwork which will require a specialist tool (ask for a ‘core cutter’ at 
your local tool hire shop).  If your hob isn’t located against an external wall, then 
one alternative is to run the extractor ducting through the ceiling void to the 
outside - but this is only possible if the upstairs floor joists run in that direction. 
The other alternative is to use a re-circulating type hood which uses filters to clean 
and de-odorise the air.

Once you’ve decided on the location of your sink and appliances it’s just a case of 
filling in the spaces on the floor with the most appropriate cabinets.  I’ll go 
through the different kinds of units available in the next section, but basically you 
can divide these up into:
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• Base units
• Wall units
• Tall units (e.g. larder units)
• Midi size units (mid size between a base unit and a tall unit)
• Corner units (base & wall types)

FURNITURE

Your kitchen furniture consists of cabinets, worktops and other fixtures.  Let’s deal 
with cabinets (units) first.

Construction: kitchen carcasses are usually made from MFC (Melamine Finished 
Chipboard) in 15 or 18mm thicknesses (some are actually made from just 12mm 
board, but these are best avoided).

15mm carcasses are ideal if:
• You are on a tight budget
• You’ve bought a “doer-upper” and just want to sell the property on
• Buy-to-Lets
• Student accommodation
• Kitchens that only see light / infrequent use

If your budget allows I would recommend, upgrading to 18mm for the following 
reasons:

• Solid backboard (normally 8mm MDF/MFC, instead of hardboard)
• Stronger / more rigid construction

 Tip: check whether the units you buy have a ‘services’ gap between the back-
board of the cabinet and the wall.  These are essential for running cables behind 
e.g. for under unit lighting.

Base Units – are usually a total of 870mm in height (720mm cabinet, plus 150mm 
legs) and 570mm in depth.  As they’re designed to sit under a worktop, these units 
come without a top panel so, if you need to know the overall height, this will 
depend on the thickness of the worktop used (normally 30 or 40mm).  In terms of 
width, they increase in multiples of 100mm i.e. 300mm, 400mm, 500mm, 600mm, 
800mm, 1000mm - the latter two sizes will come as a double-doored unit.  

You will often see base units described as ‘Highline’ or ‘Drawerline’ - this simply 
refers to whether the cabinet has a drawer or not (in the case of an 800mm or 
1000mm unit, it would obviously have 2 drawers).  In situations where it’s not 
practical to have a drawer but you would still like the appearance of one (e.g. 
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underneath a sink), then a ‘dummy’ drawer is created by joining the door and 
drawer fascias together with metal plates.

Some people have a preference for all highline or all drawerline units depending on 
the look they are trying to achieve.  All drawerline tends to lend itself to a 
traditional country kitchen look whereas it’s fashionable at the moment for many 
of the modern, high gloss kitchens to be all highline.  If you do go for this look 
though it’s wise to include at least one drawered unit e.g. a 3-pan cabinet, which 
will give you a cutlery drawer and 2 larger drawers beneath it.

It’s also perfectly okay to use a combination of both highline and drawerline units 
in your design but, where possible, try to locate drawer units next to each other.

When it comes to installing your units don’t worry if your floor is a little uneven as 
all base units come with adjustable legs (this includes tall and midi-size too).

Highline Base Unit Drawerline Base Unit 3-Pan Drawer Base Unit

Wall Units – Although only half the depth (normally 300-330mm ), wall units come 
in the same variety of widths as base units.  Because of this, it’s worth planning 
your kitchen in such a way that the doors of the wall units appear above those of 
the base units below– this creates a structured, linear look and is more professional 
(see photo).
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Wall units come in various heights; the smaller ones - sometimes known as 
‘Bridging’ units - can be used above a hob where a normal wall unit would not be 
suitable (remember you need a gap of 760mm above a hob).  Standard wall units 
are approximately 715-720mm high, but extra tall wall units are available for 
rooms with particularly high ceilings.  Keep in mind though that the maximum 
practical cupboard shelf height above a worktop is 1060mm (3’6”).

Standard Height Wall Unit Bridging Wall Unit

When installing your kitchen, aim to hang the wall units at least 450mm (18”) 
above the worksurface.

 Tip: if you plan to tile the splashback area between the worktop and wall 
units, make this gap 460mm to allow for 3 rows of 150mm (6”) tiles, plus grout 
spacers – (if you’re using this size of tile of course).

It’s also possible to create a ‘peninsular’ with wall units that juts out from the wall 
at 90˚ and is supported by legs that attach to the worktop below.  You will have to 
use a base unit end panel, or similar, to blank off the back as this would normally 
not be seen.  Some wall units are actually specially designed for this purpose and 
tend to be display type cabinets with glazed doors on both sides.

Peninsular Unit

Talking of display units, you can also get conventional glazed wall units, open end 
wall units and ‘Dresser’ units which sit on top of the worktop.
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Glazed Wall Unit Open End Wall Unit Dresser Unit

 Tip: if you are installing a Dresser unit, or indeed a tall larder-type unit, then 
these will dictate the height of the rest of your wall units.

Use cornice and pelmet to finish off a row of wall units and create the illusion of a 
single piece of furniture.

Tall Units/Larder Units – tall units can be purchased as integrated appliance 
housings with specific door sizes to suit, or as regular storage units.  Normally 
about 2170mm high (2020mm + 150mm adjustable legs), they are the same depth 
as base units at 570mm.  Most manufacturers will offer 300mm and 600mm widths 
and can often supply special pull-out wire baskets to make them easier to use.

Midi-Size Units – are a half-way size between regular base units and tall larder 
units.  They’re mainly designed for housing integrated appliances and are useful if 
you want to incorporate a ‘built-in’ double oven in your kitchen but don’t want to 
use a tall unit.  Unlike tall units, it’s common practice to finish off the top of a 
midi-size unit with a piece of worktop providing a useful raised area to put things 
on. 

Corner Units (Base & Wall) – the simplest base corner units are just regular 
straight units with only one door.  They’re designed to have another unit butt up 
against the remaining ‘opening’ at 90˚ to form an L-shape.  These can come in sizes 
varying from 800mm – 1200mm and will have a door size ranging from 300mm to 
600mm.  It’s easier to explain this with a drawing, so please see below:

Incidentally, wall units are available in the same format, but tend to be available 
in 600mm sizes only with a 300mm door.
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‘True’ corner units can be in an L-Shaped format or with a diagonal front.  For base 
units, these are normally 900mm-950mm in size and 650mm for wall units.

L-Shaped 950mm Highline 
Corner Base Unit

L-Shaped 650mm Corner 
Wall Unit

650mm Diagonal Corner 
Wall Unit

Cornice, Pelmet & Plinth – all three of these items are purely decorative and are 
used to visually ‘tie’ the units together.  When fitted, they give your kitchen the 
appearance of being a single, continuous piece of furniture.  

Cornice - is installed on the top of the wall (and larder) units and the pelmet 
attaches underneath.  

Pelmet - or ‘lighting pelmet’ as it’s sometimes known, also helps to conceal under-
wall unit lighting.

Plinth - is used to conceal the plastic adjustable legs of the base units and give the 
illusion that they are standing directly on the floor.  Alternatively, you may decide 
to purchase decorative base unit legs and do away with a plinth altogether.  These 
look very trendy when coupled with concealed lighting, but just remember that 
dust and food debris often gathers down there and will need to be cleaned 
regularly!

Fitting cornice and pelmet and achieving an acceptable finish is dependant on 
having accurate and tight fitting ‘mitre’ joints (where the wood is cut at 45˚).  This 
sort of detail can mean the difference between your kitchen looking like the one 
you saw in the catalogue and one that screams ‘amateur night’.  

Although most aspects of fitting a kitchen can be handled by a competent DIY’er, 
this task, and joining worktops (discussed later), are two that may be better 
contracted out to a professional with the right tools.

It is possible to avoid mitre joints by buying cornice/pelmet joining pieces.  These 
are moulded plastic corners that the two pieces you are joining fit into.  To be 
honest though, I think they just end up looking like a cheap short-cut.
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 Tip: A lot of the modern high gloss kitchens you see at the moment are 
pictured without cornice or pelmet to give a very minimalist look.  If you decide on 
this type of design, choose an attractive type of under unit lighting as they will 
now be seen without the pelmet to hide them.

Panels:

Base   & Wall Unit End Panels   – are used on exposed cabinet ends to disguise a white 
carcass. Sometimes referred to as ‘plant-on’ panels, they attach directly onto the 
existing side of the cabinet.  Normally used on 15mm carcasses which don’t tend to 
be ‘colour matched’ to the cabinet doors (unlike 18mm versions).

Worktop Support Panels – are used between two free-standing appliances to 
provide support and stop the worktop bowing in the middle.  They are full height 
from the worktop to the floor and can also be used to provide a professional finish 
to an open end of a run of base units.

Fitters Panel – also known as a ‘Scribing Panel’.  These are large panels, about 
2250mm x 650mm in size which can be used for a variety of purposes like fillers, 
shelves, blanking panels etc.  They will normally be available in colours to match 
your choice of carcass/door.

Breakfast Bar Back Panel – as the name suggests these large panels extend from the 
worktop to the floor and conceal the backs of the units used to create a breakfast 
bar.

Worktops: 

Chipboard / laminate – these are by far the most common and affordable worktops 
you are likely to come across and are offered in a huge variety of styles.  They will 
come in either a textured/dull finish or high gloss and are available in 30mm or 
40mm thicknesses and lengths ranging from 2.4m to 4.1m.  It’s now also possible to 
buy 60mm thick worktop to be used as a raised feature area.  These have square 
sides and a thick plastic decorative edging.

Many people are attracted to the high gloss finishes because they mimic very 
closely the appearance of natural stone (granite, marble etc).  Keep in mind 
though, that these don’t tend to be as forgiving as the textured versions if you 
place hot pans on them or use knives without chopping blocks.

Most quality modern worktops have a double rounded (‘Bull-nose’) front edge and 
incorporate a sealed ‘drip strip’ underneath.  This cures the very common problem 
with single rounded worktops of water penetrating the chipboard layer underneath 
and separating it from the hard plastic finish.  (This usually happens in front of the 
sink where water often drips over the edge – have a look at yours just now, chances 
are it’s gone the same way!)
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Width-wise, laminate worktops are available in these sizes:

• 600mm with double bull nose on one side and a square edge on the other
• 665mm with double bull nose on both sides for breakfast bar use
• 900mm with double bull nose on both sides for breakfast bar use

A couple of final words about joining worktops and finishing off cut ends. 
Depending on the standard of finish you are looking for and the budget you have 
assigned for your kitchen, you have two options to join worktop.  This will be 
necessary if you have a very long straight run and need to butt two lengths 
together or, more likely two pieces are meeting at a corner.

The cheap and easy DIY way is to buy aluminium joining strips.  The more 
expensive but infinitely better looking way is to use a router to cut a very accurate 
joint.  To do this, a special jig is required and a powerful, high quality router. 
Although these will be available from a tool hire shop, given the cost of the 
worktop if you get it wrong, it’s probably easier to get a professional in to do it.  If 
done properly, the joint will be almost invisible and will last the lifetime of the 
kitchen.

To finish off cut ends of worktop, use the edging strip supplied and attach it with 
contact adhesive (like Evo-Stick) then use a file to carefully trim away the excess. 
If you have installed a freestanding cooker or range, then you will have to use 
aluminium edging strips on these worktop ends as a stuck-on trim will eventually 
fall off with the heat.

Solid Wood – it’s true to say that nothing beats the look, feel and smell of real 
wood.  Available in several different varieties, thickness and construction, they are 
a versatile worksurface.  Just be aware though that they may require a specialist to 
fit them, may be considerably more expensive than laminate and take ongoing care 
over their lifetime.  If you do install a wooden worksurface yourself be sure to read 
the manufacturer’s instructions as most require several coats of oil to ‘seal’ them 
prior to installation.

Granite/Marble– like real wood these natural worksurfaces will be unique to your 
kitchen – no one else will have one exactly like yours.  However, this exclusivity 
comes at a price.  Natural stone is expensive to quarry, cut and finish.  Be aware of 
the flood of cheap sounding granite now available online.  I can’t comment on the 
quality of it, but the problem you will have is finding someone to cut and install it. 

Almost all of these sources will sell you straight ‘blanks’ of stone which will need 
to be cut to size, have openings made for hobs and sinks and have the edges 
polished.  You will probably find if you go down this route that you will struggle to 
find a fitter as most will only install stone which they supplied.

Simulated stone – e.g. Corian® is a beautiful material but not suitable for DIY 
installation.  If you’ve seen this worksurface on display in a showroom, you were 
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probably impressed by the integral sink bowls and invisible joints – done properly, 
it looks superb.  Best to find a good local supplier and go through your 
requirements with them – just set aside a large chunk of your budget!

INTEGRATED APPLIANCES

It’s worth mentioning at this stage a bit about integrated appliances.  These are 
designed to be concealed behind a cabinet door giving the appearance they are 
just another unit.  Some appliances are housed inside a unit whilst others are not. 
To save any doubt, check the list below:

Ovens – First, I should clear up some possible confusion about ovens.  Ovens 
designed to be ‘built-under’ a worktop are housed in a ‘Built-Under Oven Housing’ 
and can be of the single or double variety.

‘Built-Under’ Oven Housing & single oven (if fitting a built-under double oven here, 
the lower panel would be removed)

Please note, that these ‘built-under; double ovens are smaller than ‘built-in’ 
double ovens (700mm high as opposed to 900mm).  ‘Built-in’ double ovens are 
designed to be housed in a tall appliance housing e.g. a 600mm wide larder unit or 
a 600mm wide Midi unit.

Tall ‘Built-In’ Double Oven Housing Midi-Size ‘Built-In’ Double Oven Housing

(There is no such distinction when talking about single ovens – these can be both 
built-under a worktop, or housed in a tall unit.)
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Tall Housing for a Single Oven

Refrigeration – fridge/freezers can be of the 50/50 or 70/30 variety and are 
housed inside tall larder units.  Whereas ‘built-under’ individual fridges and 
freezers are not housed inside a unit – these simply have a cabinet door attached to 
the front of them.

50/50 Fridge Freezer Unit 70/30 Fridge Freezer Unit

Dishwashers, Washing Machines & Tumble Dryers – again, these just have a 
cabinet door attached to the front of them and sit directly on the floor.

Microwaves – can be supplied with a ‘building-in’ kit which normally consists of a 
stainless steel facia and support brackets.  These kind of installations are very 
effective when positioned directly above a single oven in a tall larder-type housing.

Tall Housing for a Microwave & Single Oven Installation

 Tip: when installing floor standing appliances like dishwashers, it’s sometimes 
useful to sit the appliance on top of an offcut of worktop.  This saves you having to 
screw the adjustable legs out too far and making it unstable.
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SINKS

Sinks come in a wide variety of sizes, colours and materials and in these formats: 

• single bowl
• one & a half bowl
• double bowl
• right-angled
• round

Stainless Steel Sinks – you can buy these sinks in any of the above styles.  Stainless 
steel is a popular material because its (relatively) cheap compared to other 
materials, is durable and will look at home in any kitchen, on any worktop.

Carron Phoenix Lavella 888 Stainless Steel Sink

Composite Sinks –are available in many different colours and finishes.  Because of 
their construction, some manufacturers are now offering some very trendy designs 
like this ZX150 from Carron Phoenix.  Like this sink, most are available with 
tailored accessories.

Carron Phoenix ZX150 Composite Sink

Ceramic Sinks –most people think of Belfast sinks when talking about ceramic, but 
other styles are available like the Shonelle 150 in the photo below.  If you do 
choose a Belfast style sink you will need a special lower height base unit for it as 
the front of the sink is an exposed feature of their installation.

 

Carron Phoenix Shonelle 150 Ceramic Sink
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CORNER STORAGE SYSTEMS

The only problem with incorporating corner base units into your designs is that, 
depending on the size of the cabinet, items at the back can be hard to reach.  As a 
result, people tend to clutter these with items they know they’ll probably never 
use.  The only solution used to be those flimsy plastic shelved carousels.

Carousels – are now of much better quality and tend to have fairly substantial 
chromed wire shelves and centre pole.  They are available in 180˚ and 270˚ 
configurations to be used in straight and L-Shaped corner units respectively.

1/2 Carousel 3/4 Carousel

‘Magic Corner’ – these are a very clever solution to corner storage problems and 
can really only be fully appreciated once you’ve seen one in operation.  They’re 
designed for straight corner unit installation and operate by using the action of the 
opening cabinet door to pull a set of baskets on runners from the far corner.

‘Magic Corner’ Storage System

LIGHTING

Often forgotten in the past, exciting and imaginative kitchen lighting is now 
becoming very popular.  With the advent of low voltage and LED systems you can 
now create different moods and atmospheres depending on the occasion.

Here are some examples:
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• Ceiling lighting – halogen spotlights

• Under pelmet lighting – low voltage triangular lights

• In-cabinet lighting – low voltage LED’s
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• Floor level lighting

• Cooker hood lighting

DECORATION

Kitchen decoration can transform the room and has the effect of consolidating the 
rest of the features in it.  Use complimenting or contrasting colours depending on 
the look you want to achieve and balance this with your worktop and flooring 
choices.

Apart from tiling, which I cover in the next section, you can either paper or paint 
the walls.  In all cases, try to stick to products specifically intended for kitchen use 
and which can be wiped clean easily.  Most of the big paint manufacturers these 
days offer ranges of paints that will resist the moisture and humidity found in a 
kitchen environment.

TILING

Tiling is one of those DIY jobs that most people can become quite proficient at with 
a little practice.  If you plan on doing a few tiling jobs, it’s probably worth 
spending a couple of pounds on one of those “You Can Tile” type DVD’s available in 
the large DIY stores.

To get you started though, we’ll cover some of the basics here.  One thing that 
often screams ‘amateur’, is starting with a full tile on one end of the wall and 
finishing with a very narrow line of tiles at the other end. 
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Never start tiling from one end of the wall to the other as you always want to avoid 
small, fiddly tile cuts.  Instead you will start somewhere near the centre.  To find 
your starting point, use this simple technique:

• Use a straight piece of softwood e.g. a scrap piece of skirting to make a 
‘gauging stick’

• Starting from one end, mark the size of each tile (plus spacer) along the full 
length of the wood – now cut any excess wood off at the mark of the last full 
tile.

• Measure the wall to be tiled and mark the centre
• Hold your gauging stick against the wall at your centre mark
• If you see that you’re going to be left with a distance less than half the size 

of a tile at the end of the wall, then make a new mark on the wall exactly 
half a tile away from the centre mark – this will be your starting point.

If you’re tiling a whole wall from floor to ceiling use a spirit level on your starting 
point mark, draw a straight vertical line and temporarily attach a piece of wood to 
the wall to act as a guide.

In most kitchens, tiling will form a splashback area between the worktop and the 
bottom of the wall units.  In this case, you can simply start your tiling on top of the 
worktops which will give you a level surface to start from.  If you’re tiling a whole 
wall though, use the same method as above with the gauging stick to find your 
starting point and temporarily attach a horizontal baton of wood to the wall as a 
guide.

One last thing; when it comes to grouting the tiles, don’t leave the grout too long 
before wiping off the excess.  Working on a 1m² area at a time, use your finger or a 
smoothing tool to remove surplus grout from between the tiles and wipe off the 
rest with a damp sponge.  When dry, dust off the residue with a dry cloth.

 Tip: If you are tiling on an adjacent wall to an end cabinet, allow for a packer 
(at least the thickness of the tile plus adhesive) to be fitted to the end of the base 
or wall unit to enable the door to open – if you don’t, the door will jam on the 
tiles.
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BONUS

Useful tips from a professional kitchen fitter:

• Always order an extra End Panel for your fitter to cut and make 
packers/fillers with – alternatively order a ‘scribing/fitters panel’ which is 
much bigger but often doesn’t cost much more.

• When measuring for wall and base units always allow some space at the end 
of the last unit – if necessary choose the next unit down in size e.g. a 400mm 
instead of a 500mm (this allows for walls which aren’t ‘square’ tapering 
in/out)

• Always use a Worktop Support Panel on base units that are not against a wall 
i.e. if end is visible – this looks much more professional.

• If you buy a 15mm kitchen you will probably need base and wall unit end 
panels to disguise the white carcass if a cabinet end is exposed (18mm 
carcasses are normally ‘colour matched’ to go with the door).

• Don’t install dishwashers or washing machines too far away from the sink 
because they may not be able to pump their waste water to it.

• When specifying integrated appliances, make sure there is no existing 
pipework or fittings in the intended locations.  There is normally NO room to 
accommodate pipework behind these appliances.

• If specifying a 1 1/2 bowl sink, make sure that the waste will connect to the 
drain if this exits out of the wall (instead of through the floor).  
For drains exiting out of wall:
- centre of pipe must be maximum 500mm from floor for 1 1/2 bowl sink
- centre of pipe must be maximum 620mm from floor for single bowl sink

• Remember all appliances will need power and additional sockets may need to 
be fitted e.g. extractors, microwaves etc.  If specifying an electric cooker 
(free standing or built-in) these will normally need a CCP (Cooker Control 
Point) which uses much heavier cabling – check if one exists already as this 
may have to be run direct from the house fuse box.

• Remember, for integrated appliances, the sockets cannot be sited directly 
behind the appliance.

• When fitting plinth, don’t bother to cut it to the exact height (usually about 
150mm), because floors are rarely level.  Better to make it 5-10mm short to 
account for any undulations in the floor.  When it’s fitted, you’ll never see 
the gap at the top unless you’re on your hands and knees.
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•
GLOSSARY

Appliances:

50/50 fridge freezer – a single appliance split half and half between fridge and 
freezer.

70/30 fridge freezer – a single appliance where the fridge is 70% of the volume 
and the freezer 30%.

Built-In – with reference to double ovens this normally means they are housed in a 
tall or midi sized unit at eye level (note you can also get ‘built-under’ double ovens 
which are smaller in height).

Built-Under – normally refers to single or double ovens that are designed to be 
housed in a unit under the worktop.

Canopy hood – a more traditional look where the extractor is housed in an 
ornamental canopy above the hob.

Ceramic hob – a flat glass topped electric hob that’s easier to wipe clean and heats 
up quicker than conventional electric ‘rings’.  It uses radiant heat from beneath 
the glass to heat your pots.

Chimney hood – often made from stainless steel and normally incorporating 
lighting and a variable extraction fan.  These make quite a statement in most 
kitchens and are usually specified to make a feature of the cooking area. 

Conventional Oven – A conventional oven is hotter at the top than at the bottom, 
so you can use the top for food which can be cooked quickly and the bottom for 
food which needs to be cooked more slowly (i.e. Casseroles).

Fan oven – an electric oven incorporating a fan to circulate hot air evenly within 
the oven and speed up cooking times.

Free-standing – the opposite of integrated.  These appliances are not concealed by 
a cabinet door and are not fixed to adjoining units in any way.

Halogen hob – these hobs use halogen light to provide the heat source.

Induction hob - An advance over the standard ceramic hob, the Induction Hob uses 
magnetic field technology to efficiently heat only the pan and not the hob itself.

Integrated – appliances that are concealed by a cabinet door giving the effect of 
looking like another unit e.g. an integrated washing machine or fridge freezer.
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Integrated hood – an extractor usually mounted between 2 adjoining wall units 
with a matching door attached to conceal it.

Multi-function oven – these ovens offer the option of conventional or fan assisted 
cooking depending on the type of dish you are cooking.

Recirculating – refers to an extractor that is not ducted to the outside but, 
instead, recirculates and ‘cleans’ the air.  These use 2 filters: a grease filter to 
remove air born cooking residues and a carbon filter to neutralise smells.

Semi-Integrated – usually refers to a dishwasher with the control panel on the 
outside with a drawerline size door beneath it (on fully-integrated dishwashers the 
control panel is in on the top edge of the door and is revealed when you open it).

Sinks & Taps:

Bar – a measure of pressure.  The greater the number, the higher the water 
pressure you will need to operate a particular tap.  These tend to vary from 0.1Bar 
to 1.0Bar and more.

One & a half bowl sink – a sink with 2 bowls, one normally about half the size of 
the main bowl and used for rinsing glasses, washing vegetables etc.

Undermount sink – commonly used with granite worktops, undermount sinks are 
installed beneath a very accurately cut opening in the worksurface.

Kitchen Parts:

Bullnose – refers to a simple curved design used on the front edge of worktops and 
pelmets.

Carcass – a cabinet without its door.

Cooker Control Point (CCP) – an electrical isolation switch for a built-in/under 
electric oven.  Often incorporate a single plug socket for other appliances. 
Generally located on the splashback area where it can be reached quickly if 
needed.

Cornice – decorative moulding attached to the front top edge of wall units.

Pelmet – decorative moulding attached to the front underside of wall units.  These 
tend to be used to conceal under-unit lighting.
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Plinth – or kickboard, is an upright panel at the bottom of base units used to 
conceal cabinet legs and stop dirt and dust accumulating underneath.

Splashback – decorative panel placed vertically between worktop and wall unit. 
Often used in place of wall tiling.

Upstand – a short decorative panel often matching the worktop material which 
forms a visual divide between the worktop and the wall beneath the wall units.

Unit – often used to mean a kitchen cabinet e.g. a 600 base unit.
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PART 2
How to Design Your Perfect Kitchen Using Microsoft Word

Until I started dabbling with Microsoft Word, I never realised how versatile it is. 
Like most computer programs, you just end up using a tiny fraction of the functions 
they offer.  In this guide, I’m going to show you what an ideal program Word is for 
our purposes and explain the few simple commands you need to master to create 
great looking kitchen plans.

I’ve tried several professional kitchen design packages before, but found most to 
be overly complicated and time consuming.  If I can’t get to grips with something 
within the first few minutes I lose patience pretty quickly.

THE DRAWING TOOLBAR

To use Word for our purposes we’ll be making use of the ‘Drawing’ toolbar.  If your 
version of Word isn’t already displaying this go to the main Word toolbar and click:

View ⇒ Toolbars ⇒ Drawing

Next, we need to make sure that the unit of measurement is Millimetres (mm):

Tools ⇒ Options ⇒ General ⇒ select Millimetres from the ‘Measurement units’ 
drop down box
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Now set your page up properly:

File ⇒ Page Setup ⇒ Margins ⇒ Set Top, Bottom, Left & Right Margins to 20mm – 
this will allow plenty of space for your drawing while still being within the 
printable area for your printer.  Select the Page Orientation you prefer – Portrait 
or Landscape.

Once this is done it’s time to start ‘drawing’.  Before we do though, let’s cover 
some basics.

QUICK START GUIDE

1. accurately measure the room (remember the tip about measuring at floor level 
and again at a height of 900mm, then taking the smaller of the two) 
2. note your sizes down on a simple line drawing
3. mark doors, windows , radiators, boilers and other permanent features on your 
plan
4. mark position of power sockets, light switches
5. mark position of water supply, waste pipes and gas supply if present
5. mark position of any boxed in pipes, sloping ceilings, alcoves or any other 
feature which may affect your design

DRAWING WITH WORD

For our purposes, the majority of commands we will be using will be available with 
one click straight off the Drawing Toolbar and will be for simple lines, shapes and 
text boxes.

Occasionally, we’ll also use some special commands which can normally be 
accessed by right clicking on the object you’ve just drawn and choosing an option.

Your drawings can be as elaborate or as simple as you want to make them.  You can 
add colour, text, special ‘fill’ effects and more.  I would suggest you keep them 
relatively simple though.  So long as you or your fitter can understand it and it’s 
accurate, then that’s all that really matters.

You can see a couple of examples of plans I’ve created using Word at the end of 
the section.  These should give you a good idea of what you can do quickly and 
easily with the program.

The Grid
The whole ‘key’ to successfully using Word to produce accurate drawings is to set 
up the ‘Grid’ correctly.  To do this:

Click on the Draw drop-down button on the Drawing toolbar
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Draw ⇒ Grid ⇒ 

• tick Snap Objects to Grid

• Grid Settings: Horizontal spacing: select 1mm from the drop down box

• Grid Settings: Vertical spacing: select 1mm from the drop down box

• Leave Grid Origin ticked if it is already

• Tick   Display Gridlines on screen

• Tick   Vertical every: 5mm

• Set Horizontal every: 5mm

Like most graph paper you can buy in the shops, your Planning Grid will now be 
made up of 5mm squares.
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When designing your kitchen you will find that 100mm is a significant size, because 
this size will be the building block for your kitchen plan.  As you’ve already read, 
most kitchen units and appliances are sized in multiples of 100mm.  

We’ll be creating our plan to a scale of 1:20 so each 5mm square on your plan will 
represent a length of 100mm on your kitchen floor.  This makes it very easy to 
layout your cabinets and appliances as you will see.

DRAWING LINES & SHAPES

Toolbar Buttons
By default, once you’ve placed the Drawing toolbar on your screen then all of the 
drawing commands I’m about to refer to should be showing.  If any are not, you 
can easily add them:

Look for the little black down-pointing arrow at the very end of the Drawing 
toolbar.  Click this so that you see, ‘Add or Remove Buttons’.  Select the ‘Drawing’ 
option.  Now click this to reveal all available Drawing tools and add the ones you 
require.

Using the buttons in the picture below will allow you to draw straight lines, arrows, 
squares/rectangles, circles/ovals and text boxes.

Here are some examples of what these buttons will draw on-screen:
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The Drawing ‘Canvas’
When you click a Drawing button, Word will create a Drawing Canvas for you with 
the words “Create your drawing here”.  Don’t worry if it looks too small just now, 
you can make it bigger once you’ve placed an ‘object’ inside it (I’ll refer to any 
line, shape or element you draw as an ‘Object’ for now).

Once you’ve started to draw something the canvas will become ‘highlighted’ and 
will have black ‘resizing handles’ on its sides and corners.  Click any of these to 
resize the canvas.

Creating Lines, Rectangles and Circles
(The instructions I give you here are the same for virtually any object you create.)

Start by clicking the ‘Line’ button on the toolbar:
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Your drawing canvas will now be highlighted and the cursor will change to 
crosshairs when it’s inside it.  Place the start of the line/object roughly where you 
want it to be and extend the line by moving your cursor.  

Whenever you want to work with this object just click it and a small circle will 
appear at either end (or on its corners if you’re drawing a box).  

When you hover over or inside an object the cursor will change to the arrow cross-
hairs shown above, meaning you can click and move it wherever you want to on the 
canvas.  If you hover over the little circles at the edge of the object, then the 
cursor will change to the third, ‘re-sizing’, type and let you change the size or 
length of the object.

 Tip: with circles, rectangles and certain ‘Autoshapes’ you will notice an extra 
‘green’ coloured circle in addition to the other little circles that appear when you 
click inside an object.  By clicking on this circle you can rotate the object about its 
axis.

To draw a simple square, for example, just click the Rectangle drawing button and 
place your cursor where you want the object on-screen.  Use the different cursors 
mentioned above to move and resize it the way you want, using the 5mm grid we 
setup as your guide.

So, to draw a typical 600mm base unit on your plan, you would draw a box 6 
squares wide by 6 squares deep. (i.e. approximately 600mm wide x 600mm deep).
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If you wanted to draw a 1000mm base unit you would draw a box 10 squares wide 
by 6 squares deep.  To draw a typical 600mm wall unit (which are normally 
approximately 300mm deep), your box would be 6 squares by 3 squares.  Easy, 
right?

Other Shapes
At the end of the day, most of the objects you will be drawing on your plan are just 
straight lines and boxes!  The big advantage to using Word though over a pencil and 
paper is the ease with which you can change your design and moves things around. 
Remember, 100mm is our magic number when it comes to kitchen planning and 
using the grid lets you know straight away if something’s going to fit or not.

Occasionally though, you may need to create a special shape.  Thankfully, Word 
has lots of these available to help us:

Look for ‘Autoshapes’ on the Drawing Toolbar and click it.  You now have the 
following choices:

• Lines
• Connectors
• Basic Shapes
• Block Arrows
• Flowchart
• Stars and Banners
• Callouts

Occasionally you may have use for options in the ‘Lines’ and ‘Connectors’ groups, 
but the only ‘special shape’ I tend to use is the ‘Rounded Rectangle’ from the Basic 
Shapes family which is perfect for drawing sinks.  I drew the one below in under a 
minute using only rounded rectangles, circles and straight lines.  Open up Word 
just now and have a go – once you get the hang of it, it’s a piece of cake!
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 Tip: Once you’ve created an item like the sink above, which consists of 
several different objects, how do you move it if you need to?  Rather than try to 
move each individual item, then re-align them in their correct position, hold down 
the Control button on your keyboard then click each item in turn until they’re all 
highlighted.  You can then move them as a complete group of objects.  Or, from 
just outside of the group, left click your mouse and drag a highlighting box over all 
of them.  When you let go of the mouse button all objects will be highlighted. 
Move your cursor within the group until you have the ‘Positioning’ type of cursor, 
left click and move the whole group to its new position.  You will find these two 
techniques handy in many situations.

Text Boxes
Often it’s useful to name the different elements on your plan so both you and 
you’re fitter know what they are.  To add text, click the Textbox icon on the 
toolbar.

A box will appear on the canvas with a prompt ready for you to type.  You can 
format the text by highlighting it and using any of the normal text commands e.g. 
Font, Font Size, Bold, Italics, Underline etc. 

You will notice the textbox automatically appears with a black line around it.  It’s 
personal choice, but I prefer it not to have this.  If you’d also like to remove it, 
right click the edge of the box and click the ‘Format Text Box’ option.

Now click the ‘Colors and Lines’ tab at the top of the dialogue box.  In the ‘Line’ 
section click the Color drop-down box and select ‘No Line’.  

You can move, enlarge/reduce, copy & paste textboxes in exactly the same way as 
any other Drawing object.

Object ‘Order’
Sometimes, depending on the order in which you create the different objects in 
your plan you can end up with one object that is effectively ‘sitting on top’ of 
another.  For example, in an earlier drawing when we were talking about layouts I 
showed the dotted line of an integrated appliance sitting ‘underneath’ a sink.
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The drawing you saw was effectively two ‘layers’.  I drew the first layer (the 
appliance) and then I drew the sink.  If you ever need to change the order of these 
‘layers’ in your drawings, use this technique:

Right click the object whose order you want to change ⇒ Order ⇒ Select Bring to 
Front or Send to Back

Colour & Fill Effects
If you want to add a touch of colour to your drawing to brighten it up or make an 
object stand out it’s very easy (I tend to colour my wall and larder units so it’s 
obvious they’re a different height to the base units).

Highlight the object you want to colour and select the fill colour tool from the 
toolbar.

Alternatively, 
Right click the object ⇒ Format Autoshape ⇒ Colors and Lines ⇒ Color

When you click Color you will see there is also an option called ‘Fill Effects’ which 
allows you to use shading or hatching effects like this:

DRAWING THE ROOM OUTLINE

Okay, now we’ve covered drawing basics, let’s transfer your measurements onto 
Word and create the outline of the room.

Let’s say for example, you have a rectangular shaped room with dimensions of 
3540mm x 2810mm.  In theory you could count out 35.4 ‘squares’ by 28.1 ‘squares’ 
on the drawing grid (as each square = 100mm).  This is a bit tedious though.  Here’s 
how to get your drawing exact:

If you’re good at mental arithmetic you can do this in your head, otherwise get a 
calculator out and divide each of your dimensions by 20.  In the above example this 
gives us 177mm by 140.5mm.  These are the dimensions you will be using on your 
drawing.
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We already know how to draw lines, so go ahead and create a straight line on your 
canvas.  Keep it highlighted (little circles at each end), then right click with your 
mouse.  As well as the usual Cut, Copy & Paste commands, you’ll notice ‘Format 
Autoshape’. Click this and go to the ‘Size’ tab at the top.  

Depending on whether your straight line is a vertical or horizontal line, either the 
Height or Width parameter will equal 0.00mm – the other size will be whatever 
length the line happened to be when you drew it.  Replace this size with whichever 
of the two dimensions we just calculated, as appropriate (it makes sense to draw 
the longest sides of your room on the longest side of your page - depending on 
whether your page is setup in Landscape or Portrait format).

By now you should have one line on your page which accurately represents one side 
of your room.  Hover your cursor right on top of this line and right click to reveal 
the Copy command.  Click this, then right click again to Paste (these commands are 
also available from the ‘Edit’ tab on the main Word toolbar).

Hover over the second line you’ve just created until the cursor becomes the 
Positioning type and move the line to the other side of the page.  Now repeat this 
process for the two lines you’ll need to form the other two walls of the room. 
When all four lines are accurately drawn and roughly in position, move them as 
necessary to create the four corners.

 Tip: you may not need to draw all four walls of the room depending on your 
layout – you might only need to draw two or three.

Adding Dimensions to Your Drawing
It’s useful, particularly if you are giving your plan to a fitter, if you mark the room 
dimensions on it.  The accepted way is with a double-ended arrow and the length 
in Millimetres beside it.  To do this, follow these steps:

Autoshapes ⇒ Lines ⇒ (choose the double-ended arrow)
Place the arrow parallel to the line whose dimension you want to indicate, then 
resize it so it’s exactly the same length.  Create a small textbox next to it and 
enter the dimension in ‘mm’.

Adding Units & Appliances to Your Plan
Creating the outline of your room accurately on the page is perhaps the most 
important aspect of your kitchen plan.  After that, it’s really just a case of 
arranging the appliances and units to make best use of your space in a logical 
layout.  Let’s quickly re-cap on some common sizes:

(For the purposes of drawing kitchen plans on Word, I tend to show base units as 
being 600mm deep whereas in reality most are between 570mm – 590mm.  This 
just makes the drawing easier to read as standard worktop is 600mm deep and is 
attached to the base units anyway.)
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Base Units Widths: (I’ll mention as many permutations as I’m aware of)
• 150mm (often wine racks or wire basket pull-out units)
• 300mm
• 400mm
• 450mm
• 500mm
• 600mm
• 800mm
• 900mm (tend to be corner units)
• 950mm (tend to be corner units)
• 1000mm
• 1200mm

Wall Unit Widths:
• 300mm
• 400mm
• 450mm
• 500mm
• 600mm
• 650mm (tend to be corner units)
• 800mm
• 1000mm

Tall Unit Widths
• 300mm
• 500mm
• 600mm

 Tip: Check with your supplier first to confirm which units are available before 
creating your plan.

Appliance Widths (Integrated):

• 450mm (Slimline dishwashers)
• 600mm (washing machines, tumble dryers, most integrated fridges & freezers, 

most integrated ovens

Free-standing appliances tend to be manufactured in similar sizes to those above, 
but there are variations.  Again, check with your supplier before adding them to 
your plan.  Note: a lot of the newer American style fridge freezers are considerably 
bigger than 600mm. 

We’ll draw a few units now, just to hang the hang of it:
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 Tip: If you want to represent an integrated appliance draw two squares – one 
inside the other.  Give the smaller a dotted line to show there is a concealed 
appliance.  To do this, follow these steps:

Right click object ⇒ Format Autoshape ⇒ Colors and Lines (tab) ⇒ Line ⇒ 
Dashed ⇒ (select from drop down box)

 Tip: To help you, I’ve put together a series of video tutorials to accompany 
this guide which you can view online by clicking here.

DRAWING YOUR PLAN FROM OTHER VIEWS

Up until now we’ve just created ‘Plan’ views of our kitchen i.e. shown as if you 
were looking down on them from above.  You can also draw individual walls as if 
you were looking straight at them:
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Time to Measure Up & Create Your Own Perfect Kitchen!

Okay, it’s time to transfer your measurements onto Word and have a go at 
designing your own dream kitchen.  It’s not difficult and, with a little practice, you 
will find that you can quickly create imaginative layouts that make the most of the 
space you have available.

Once you’re ready to order your kitchen why not take a look at the wide selection 
of styles available on our website.  We carry a full range of units, worktops, 
appliances, sinks, taps & accessories all available online ready for dispatch 
throughout the UK.

If you’re a property developer, contractor or just a first time buyer looking for the 
latest styles at discount prices you may also want to take a look at our new budget 
kitchen site.

www.CutPriceKitchens.co.uk

50/50 
Fridge/Freezer

300 
Base 
Unit

500 
Base 
Unit

500 4-
Drawer 
Base Unit

600 
Base 
Unit

Single 
Built-
Under 
Oven

300 
Wall 
Unit

500 
Wall 
Unit

500 
Wall 
Unit

600 
Wall 
Unit

600 
Chimney 
Extractor
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600mm 
wall unit

500mm 
wall unit

600mm 
larder unit 
with 50/50  

fridge/freezer
Chimney 
Extractor

500mm base 
unit with 
drawer

500mm 
base unit 

400mm 
base unit 

F/Standing 
washing 
machine 

F/Standing 
tumble 
dryer 

1000mm 
base unit 

with single 
bowl sink  & 
mixer tap

Stainless 
steel gas 

oven & hob 

Full height units & wall units
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Hopefully you should now feel confident enough to have a go with your own design, 
but if you need any more help why not take a look at the tutorial videos. 

Your dream kitchen awaits you!     Thanks for reading.

www.CutPriceKitchens.co.uk

F/S Fridge 
Freezer

Integrated 
Dishwasher

400 wall unit

500 glazed 
wall unit

500 glazed 
wall unit

400 wall unit

5-burner 
S/steel gas 
hob

600 3-drawer 
pan base unit

1000 base unit 
with Magic 
Corner

600 base unit 
with single 
bowl sink

90cm Glass & 
S/Steel 
Chimney 
Extractor

150 wine rack 
base unit

1000 base unit 
with Carousel

500 base unit

F/S Washing 
Machine
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